
Xerox 6705

Stručný průvodce



Úvod

Děkujeme, že jste si vybrali velkoformátové zařízení  Xerox 6705.

Tento průvodce přináší základní přehled o funkcích a vlastnostech zařízení dále popisuje základní operace a procesy
údržby pro jeho bezchybný provoz.

Tento průvodce předpokládá Vaše základní znalosti používání osobního počítače a síťového prostředí. Pro základní informace
a instrukce použití Vašeho počítače v síťovém prostředí se obraťte na dokumentaci spojenou s Vaším osobním počítačem  
a síťovým systémem. 

Po přečtení tohoto průvodce jej uchovejte na dostupném místě pro případ potřeby pomoci, v případě vzniklých problémů  
s nastavením zařízení nebo dojde-li k technické poruše.

Značky Microsoft a Windows jsou ochrannou známkou společnosti Microsoft Corporation v U.S.A. a v dalších zemích. 
Veškeré produkty/značky jsou ochrannou známkou příslušných vlastníků. 
Reprodukce screenshotu(ů) aplikací společnosti Microsoft je povoleno pouze s povolením společnosti Microsoft Corporation. 

V tomto manuálu jsou bezpečnostní pokyny a informace označeny symbolem       . Před použitím doporučujeme vždy přečíst 
tyto informace a postupovat dle uvedených pokynů. 

DŮLEŽITÉ:

1. Tento manuál je vlastnictvím výrobce a vztahují se na něj veškerá práva a povinnosti vyplývající z autorského zákona.  
 Bez písemného souhlasu vydavatele nelze tento manuál kopírovat, distribuovat či ho měnit ať už v celkovém  
 rozsahu nebo jen vybrané části.
2. Části tohoto dokumentu mohou být vydavatelem změněny bez předešlého upozornění.
3. Uvítáme veškeré připomínky týkající se nepřesností, chyb, vynechání textu či dokonce chybějících stránek. 
4. Používejte zařízení k předepsaným úkonům. Veškeré nepopsané procesy a úkony mohou vést k poškození zařízení.  
 Fuji Xerox není zodpovědná za jakékoliv problémy se zařízením vzniklých z nedoporučených úkonů a nesprávným  
 používáním zařízení. 

Export tohoto zařízení je přísně kontrolováno ve spojení se zákony zahraničního obchodu Japonska a /nebo regulacím  
vývozu U. S. A. 

Xerox a jeho loga, CentreWare a DocuWide jsou ochrannými známkami společnosti Xerox ve Spojených státech amerických 
nebo společnosti Fuji Xerox Co., Ltd.  
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Vlastnosti zařízení

Tisk

Skenování

Kopírování

Kopírování: umožňuje jednoduše kopírovat pomocí 
dotykového panelu soubory různých velikostí  
s možností zvetšení/zmenšení kopie vůči originálu. 
(více na straně 10)

 Features of the Machine4

Features of the Machine

Enables easy copying, not only same-size copying 
but also reduced/enlarged copying and more, using 
the touch screen. (Refer to p.10)
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Umožňuje tisk z libovolné aplikace pomocí 
tiskového ovladače (více na straně 22)

Tisk s použitím tiskového ovladače

Tiskové úlohy mohou být v tiskovém zařízení dočasně 
uchovávány a vytištěny pomocí příkazu na tiskovém 
zařízení. Toto je nazýváno „důvěrným tiskem“, který lze 
rozdělit na dva typy: Zabezpečený tisk a Soukromý tisk 
(více na straně 23)

Důvěrný tisk

Skenování dat do složek
Skenované dokumenty mohou být ukládány do složek  
na pevném disku zařízení. Tyto dokumenty mohou být  
následně importovány síťovým připojením pomocí  
následujících metod:

• Import přes TWAIN-podporující aplikace
• Import přes Folder Viewer 3
• Import použitím CentreWare Internet Services

Skenování do PC
Skenované dokumenty lze ukládat na síťové úložiště 
(PC, Server). (Více na straně 16)

Multisend
Skenované dokumenty mohou být ukládány  
na počítače (servery) registrované ve skupině  
adres a mohou být tištěny na tiskovém zařízení. 
(Více v uživatelském návodu)

5 Features of the Machine

Printing Using the Print Driver Confidential Print

Enables printing from an application using the 
print driver. (Refer to p.22)

Store to Folder
Documents can be read (scanned) on the machine to be stored as 
data in the machine's Folders. The stored documents can be 
imported from a network-connected computer using the following 
three methods: (Refer to User Guide.)

Import from a TWAIN-compliant application

Import from Folder Viewer 3

Import using CentreWare Internet Services

Print data can be stored in the machine temporarily to be printed 
only with the print command from the machine. This is called 
"Confidential Print". There are two types of Confidential Print: 
Secure Print and Private Charge Print. (Refer to p.23)

Scan to PC
Documents can be read (scanned) on the machine to be saved as 
data on a network-connected computer (server). (Refer to p.16)

Multi Send
Scanned data can be saved on computers (servers) registered as a 
group address, and can be printed from the machine. (Refer to 
User Guide.)
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Manuály

Následující návody a manuály jsou poskytovány se zařízením.

Průvodce pro tiskové zařízení

● Stručný průvodce (tento dokument)

Představuje hlavní vlastnosti a funkce zařízení. Popisuje základní procesy pro použití zařízení a důležité kroky pro údržbu 

zařízení. 

● Uživatelský průvodce

Popisuje procesy údržby zařízení. Jak používat funkce kopírování/skenování/tisku, jak odstranit zaseknutý papír či jak  

pracovat s různými nastaveními zařízení. Dále jsou zde popsány varování a omezení při použití zařízení.

Průvodce pro volitelné příslušenství 

Tento průvodce poskytuje informace o použití volitelných doplňků a informace o instalaci potřebného softwaru. 



7 Conventions

Conventions

This guide uses the following marks depending on the described contents.

Important Provides important information that you should know and check before using or operating the 
machine.

Note Provides information that may be useful when you are using or operating the machine. 

Refer Provides cross-references to the content.

The following symbols are used in this guide.

The screen shots and machine illustrations in this guide are of the machine with various optional components 
installed. Some of the items and features on the screen shots or illustrations may not be displayed or available on 
your machine depending on its configuration.

The information on various drivers and utility software in this guide may not apply to your drivers and utility 
software depending on their version upgrade. 

In this guide, "personal computer" and "work station" are collectively called "computer".

Microsoft® Windows® Operating System is referred to as "Windows".

The description of operations in this guide are mainly based on Windows® 7. If using an operating system other 
than Windows® 7, the operating procedures and the screen appearance may be different in your environment. 

"   " A cross-reference included in this guide.

Indicates the names of features, input values, input examples, and the messages displayed on 
the touch screen.

[     ] Indicates the names of the screens, menus, buttons, and tabs displayed on the touch screen. 

Indicates the names of the menus, windows, dialog boxes, buttons, tabs, files, and folders 
displayed on your computer screen. 

<    > Indicates the buttons and indicators on the control panel.

Indicates the keys on your computer keyboard.

> Indicates the order of selecting the menu items.
Example: Select [Start] > [All Programs]. 

Poznámka

Odkaz

Obecné zásady

Tento průvodce obsahuje následující značky v závislosti na typu obsahu

Jedná se o důležité informace, které by měl uživatel znát před použitím zařízení. 

Jedná se o informace, které mohou být užitečné při používání zařízení. 

Jedná se o poskytnutí reference na jiný obsah. 

Ostatní symboly použité v tomto průvodci

„   „  • Jedná se o odkaz na obsah, který je součástí tohoto dokumentu. Takto jsou označovány názvy funkcí, 

  hodnoty, příklady vložených hodnot a zprávy zobrazené na dotykovém panelu. 

[   ]  • Takto jsou označeny názvy panelů, menu, tlačítek nebo oddělovačů či záložek, souborů a složek zobra- 

  zených na dotykovém panelu. Taktéž jsou takto označována menu, okna, dialogová okna, tlačítka,  

  oddělovače či záložky, soubory a složky zobrazené na monitoru PC.

<   > • Označuje tlačítka a ukazatele na kontrolním panelu. Taktéž jsou takto označovány klávesy  

  na klávesnici PC.

>  • Označuje pořadí položek v menu.  

  Příklad: Select [Start] > [All Programs]. 

● Použité ilustrace a zobrazení dotykového displeje se mohou měnit dle použitých a instalovaných doplňků. Některé prvky 

 nebo menu nejsou dostupné ve vybraných konfiguracích.

● Informace týkající se tiskového řadiče a funkcí instalovaného softwaru se mohou měnit v závislosti na typu řadiče a verzi 

 instalovaného softwaru. 

● V tomto průvodci je název „PC“ souhrnně vztahován vůči osobnímu počítači, tak i k pracovní stanici.  

● Microsoft® Windows® Operating System je zkráceně nazýván „Windows“.

● Popisované činnosti v tomto průvodci jsou spojeny s operačním systémem Windows 7. Pokud používáte jiný typ OS, tak 

 některé procesy, či vzhled menu mohou být rozdílné. 



Zařízení

Kontrolní panel 

Tlačítka, indikátory a dotykový 
displej pro ovládání zařízení. 

Výstupní podavač
Kopírované nebo tištěné  
dokumenty budou vykládány zde 
horní stranou vzhůru.

Zapnutí/vypnutí
Zapnutí/vypnutí zařízení se zapnu-
tým elektrickým jističem.

Elektrický jistič
Vypněte elektrický jistič pro vypnutí 
zařízení ze sítě. 

Podavač dokumentů
Zde podávejte dokumenty  
určené ke skenování. 

Výstupní vykladač
Zde jsou ukládány dokumenty  
ze zařízení. 

Čelní dveře zařízení
Použijte tyto dveře pro výměnu 
typu papíru.  
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Job Status

Machine Status

Dial Pause Speed Dial
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GHI JKL MNO

PQRS TUV WXYZ Interrupt

Start

Stop

Clear All

Log In / Out

Energy Saver

Zapnutí/vypnutí zařízení

Následující informace popisují jak zapnout/vypnout zařízení.

Zapnutí zařízení

Kroky

Pro zapnutí zařízení zmáčkněte tlačítko do pozice [ | ].

Po zapnutí zařízení počkejte do okamžiku, kdy je  
zařízení bezpečně nastartováno a displeje korektně  
fungují. Pokud dojde po zapnutí k opětovnému  
vypnutí, hrozí ztráta zpracovávaných dat. 

Vypnutí zařízení

Kroky

Pro vypnutí zařízení zmáčkněte tlačítko do pozice  [        ] .
Po zobrazení zprávy na displeji dojde k vypnutí zařízení. 

Nevypínejte zařízení při následujících situacích.  
Pokud tak učiníte hrozí ztráta zpracovávaných dat.

- Data jsou přijímána (Indikátor <Data> bliká).
- Probíhá tisk
- Probíhá kopírování
- Probíhá skenování

Po opuštění papíru ze zařízení (tisk/kopírování/skenování) čekejte minimálně 5 vteřin, než vypnete zařízení.

Při vypnutí zařízení a opětovném spuštění se ujistěte, že indikátor <Main Power> je vypnut  
ještě předtím, než dojde k opětovnému spuštění. 

Nevypínejte elektrický jistič při zapnutí zařízení. Může dojít k poškození zařízení. 

Opuštění módu energetické úspory 

Mód energetické úspory je ukončen při následujících podmínkách:

Při zmáčknutí tlačítka <Energy Saver> na kontrolním panelu.

Při přijetí úlohy ke zpracování.

Tlačítko <Energy Saver>
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 1.

Document

A2

A1

Copied output

Enlarging

originál

zvětšení

kopie

Kopírování

Kopírování v definované velikosti papíru (Automatický mód)

Automatický mód je funkce umožňující přednastavení velikosti výstupního formátu pro každý dokument pomocí 
tabulky. Funkce automaticky zvětšuje/zmenšuje obraz podle velikosti nastavení pro kopírování.
Následující příklad popisuje jak vložit originální dokument formátu A2 (orientace portrét) a kopírovat zvětšený  
formát na hodnotu 141,4% na roli papíru A1. (A1 v roli při orientaci portrétu). (Zvýrazněná hodnota je nastavena).

V hlavním menu zmáčkněte tlačítko kopírovat [Copy]

Kroky

 Copy10

Copy

Copying in the Specified Paper Size (Auto Mode)

Auto Mode is a feature that allows you to pre-configure an output paper size for each document size using a matrix. 
The feature automatically reduces/enlarges images based on this configuration when copying.
The following describes as an example how to insert an A2 standard-size document in the portrait orientation, and 
make enlarged copies (141.4%) thereof on A1 paper (A1 roll paper in the portrait orientation) (The value 
surrounded with a square in the figure below is the set value).

Steps

 1. On the menu screen, press [Copy].

Document

A2

A1

Copied output

Enlarging

 Copy10

Copy

Copying in the Specified Paper Size (Auto Mode)

Auto Mode is a feature that allows you to pre-configure an output paper size for each document size using a matrix. 
The feature automatically reduces/enlarges images based on this configuration when copying.
The following describes as an example how to insert an A2 standard-size document in the portrait orientation, and 
make enlarged copies (141.4%) thereof on A1 paper (A1 roll paper in the portrait orientation) (The value 
surrounded with a square in the figure below is the set value).

Steps

 1. On the menu screen, press [Copy].

Document

A2

A1

Copied output

Enlarging
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 2.
 3.

 4.

 5.

 6.

 7.

　　

Job Status

Machine Status

Services Home Copy (Not In Use) Review

1 2 3

4 5 6

7 8 9

0 ＃

C

ABC DEF

GHI JKL MNO

PQRS TUV WXYZ

Dial Pause Speed Dial

Interrupt

Start

Stop

Energy Saver

Log In / Out

Clear All

Poznámka

Vyberte Automatický mód [Auto Mode].

V tabulce vyberte formát [A2] pro [Originální velikost]  
a formát [A1] pro [Zdroj papíru].

V případě potřeby nastavte další vlastnost.

Zvolte pomocí klávesnice počet požadovaných kopií. 

Počet zvolených kopií se objeví v menu vpravo nahoře. 

Zarovnejte originální dokument s vodičem do podavače  
skenovanou stranou dolů. Vkládejte dokument dokud se proces 
nezastaví.

Odeberte dokument při výstupu ze zařízení

Je možné posunout vodič dokumentu vpravo pro  
zarovnání skenovaného dokumentu. 

Podržte dokument ve správné pozici do doby, než bude  
unášen. Pokud je dokument dlouhý je možné vypadnutí  
ze zařízení. 

Pokud se objeví chybová zpráva na displeji, postupujte podle 
návodu na displeji. 

Poznámka

Dokument je automaticky unášen a krátkodobě zastavován.

Následně zařízení začne skenovat dokument automaticky. 

11 Copy

 2. Select the [Auto Mode] check box. 

 3. On the matrix, select [A2] for [Original Size] and [A1] for 
[Paper Supply].

 4. Set other features as necessary. 

 5. Enter the number of copies using the numeric keypad. 

The number of copies entered appears on the upper right of 
the touch screen. 

 6. Align the document against the document guide with the 
side to be copied face down, and insert it all the way until it stops.

Note You can shift the document guide to the right to shift the 
scanning position of the document. 

The document is automatically conveyed and stops momentarily. 

Then the machine automatically starts scanning the document. 

Important Do not release your hands from the document until it is 
conveyed. If the document is long, it might fall off the 
machine. 

Note When a problem occurs, an error message is displayed on the touch screen. Resolve the problem 
according to the message. 

 7. Remove the document that is output. 

　　

Job Status

Machine Status

Services Home Copy (Not In Use) Review

1 2 3

4 5 6

7 8 9

0 ＃

C

ABC DEF

GHI JKL MNO

PQRS TUV WXYZ

Dial Pause Speed Dial

Interrupt

Start

Stop

Energy Saver

Log In / Out

Clear All

Numeric Keypad

Document guide

11 Copy

 2. Select the [Auto Mode] check box. 

 3. On the matrix, select [A2] for [Original Size] and [A1] for 
[Paper Supply].

 4. Set other features as necessary. 

 5. Enter the number of copies using the numeric keypad. 

The number of copies entered appears on the upper right of 
the touch screen. 

 6. Align the document against the document guide with the 
side to be copied face down, and insert it all the way until it stops.

Note You can shift the document guide to the right to shift the 
scanning position of the document. 

The document is automatically conveyed and stops momentarily. 

Then the machine automatically starts scanning the document. 

Important Do not release your hands from the document until it is 
conveyed. If the document is long, it might fall off the 
machine. 

Note When a problem occurs, an error message is displayed on the touch screen. Resolve the problem 
according to the message. 

 7. Remove the document that is output. 

　　

Job Status

Machine Status

Services Home Copy (Not In Use) Review

1 2 3

4 5 6

7 8 9

0 ＃

C

ABC DEF

GHI JKL MNO

PQRS TUV WXYZ

Dial Pause Speed Dial

Interrupt

Start

Stop

Energy Saver

Log In / Out

Clear All

Numeric Keypad

Document guide



12

 1.
 2.
 3.

 4.
 5.

 6.

Vložení papíru manuálně

Nestandardní velikosti papíru, nebo formáty, které nepoužíváte příliš často lze vkládat manuálně ze vstupního  
podavače.

Pokud vložíte rozdílný formát, než je specifikováno může dojít ke ztrátě části obrazu nebo obraz může být kopíro-
ván s nežádoucími okraji.

Může být vložen papír o maximální délce 2000mm. 

Kroky

V menu vyberte kopírovat [Copy].

Ujistěte se, že automatický mód [Auto Mode] je vypnut.

Zmáčkněte [       ].

Vyberte sadu papíru [Paper Series], typ papíru [Paper Type]  
a plošnou hmotnost [Paper Weight] 

Zmáčkněte [Close]

V případě potřeby zvolte další nastavení. 

Pro otevření podavače ho sklopte směrem k sobě. 

Poznámka

5.

 Copy12

Loading Paper from the Bypass (Manual) Feed Table (Bypass Copy) 

Non-standard size paper and paper of sizes you do not use very often can be copied from the bypass (manual) feed 
table. 

Important If you load paper of a size that is different from the one you specified, part of the image may be lost, or the 
image may be copied with unwanted margins. 

Note Paper of up to 2,000 mm in length can be loaded. 

Steps

 1. On the menu screen, press [Copy]. 

 2. Make sure that the [Auto Mode] check box is deselected. 

 3. Press [ ]. 

 4. Select [Paper Series], [Paper Type], and [Paper Weight]. 

 5. Press [Close]. 

Set other features as necessary. 

 6. Fold the bypass (manual) feed table toward you to open 
it. 
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 7.

Important

 8.

 9.

 1.
 2.
 3.
 4.

 5.
 6.
 7.

Zarovnejte pravý roh dokumentu naproti měřítku a vkládejte  
papír, dokud neuslyšíte pípnutí. Papír je automaticky unášen  
a následně zastaven.

Vždy vkládejte pouze jeden arch

Pokud se papír kroutí, podržte jej oběma rukama  
v rozích. Zajistíte tak správné vložení do podavače.

Nepouštějte papír dokud není zařízením navinut.  
Pokud upustíte papír a uslyšíte zvuk, je možné,  
že došlo k jeho zaseknutí.

Zarovnejte dokument oproti vodítku kopírovanou stranou dolů  
a vložte celý dokument, dokud nedojde k jeho zastavení. 
Dokument je automaticky unášen a je náhodně zastavován.
Následně dojde k automatickému spuštění skenování. 

Po ukončení kopírování vraťte podavač do původní polohy.

Kopírování dlouhých dokumentů

Níže je popsán příklad kopírování dokumentu se šířkou formátu A1 a délkou 3000 mm na roli papíru o šířce A1 
beze změny proporcí.

Kroky

V menu vyberte kopírovat [Copy].

Vyberte Automatický mód [Auto mode].

Zmáčkněte položku Synchronizováno [Synchronized].

V tabulce se ujistěte, že zvolený formát originálu  
[Original Size] i kopie [Paper Supply] je formát [A1]. 

V případě potřeby zvolte další nastavení.

Vložte počet kopií pomocí numerické klávesnice.

Zarovnejte dokument skenovanou stranou dolů  
a postupně vkládejte celý dokument do zařízení. 

Dokument je automaticky unášen a je náhodně zastavován.

Následně dojde k automatickému spuštění skenování.

13 Copy

 7. Align the right edge of the paper against the scale, and insert the 
paper until you hear a beep. 

The paper is automatically conveyed and stops. 

Important Load paper one sheet at a time. 

If paper is curled, hold the curled corners with both 
hands when inserting the paper. 

Do not release your hands from the paper until it is 
conveyed. If you release your hands when you hear a 
sound, the paper may get jammed. 

 8. Align the document against the document guide with the side to be copied face down, and insert it all the 
way until it stops. 

The document is automatically conveyed and stops momentarily. 

Then the machine automatically starts scanning the document. 

 9. When copying is finished, put the bypass (manual) feed table back to the original position. 

Copying Long Documents

The following describes as an example how to copy an A1 width 3,000 mm length document onto A1 roll paper in 
the same width and length. 

Steps

 1. On the menu screen, press [Copy]. 

 2. Select the [Auto Mode] check box. 

 3. Press [Synchronized]. 

 4. On the matrix, make sure that [A1] is selected for both 
[Original Size] and [Paper Supply]. 

 5. Set other features as necessary. 

 6. Enter the number of copies using the numeric keypad. 

 7. Align the document against the document guide with the 
side to be copied face down, and insert it all the way until 
it stops. 

The document is automatically conveyed and stops momentarily. 

Then the machine automatically starts scanning the document. 
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 1.
 2.
 3.

 4.
 5.

 6.

 7.
 8.

 9.

 10.

Více dokumentů lze spojit do sady, pokud jsou jejich kopie na výstupu.

Kroky

V menu vyberte kopírovat [Copy].

Vyberte záložku výstupního formátu [Output Format].

Zmáčkněte kopírovat výstup [Copy Output…].

Zmáčkněte [Collated].

Vyberte požadované položky.

Vložený arch
Vyberte si, zda chcete využít vloženého archu. Tento arch  
bude mít na sobě vytištěn počet kopií a čas produkce. 

Pořadí složení
Vyberte, zda se kopie mají skládat v pořadí od prvního  
skenovaného dokumentu (In Order) anebo od posledního  
dokumentu (Reverse Order).

Zmáčkněte zavřít [Close].

Nastavte další parametry v případě potřeby.

Vložte požadovaný počet kopií pomocí numerické klávesnice.

Vložte první dokument. 

Skenování začíná.

Vložte další dokument.

Opakujte tento krok v případě většího množství dokumentů.

Po naskenování posledního dokumentu zmáčkněte  
tlačítko poslední originál [Last Original].

Kopírování více dokumentů 
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Copying Multiple Documents (Collation)

Multiple documents can be collated into sets when their copies are output. 

Steps

 1. On the menu screen, press [Copy]. 

 2. Press the [Output Format] tab. 

 3. Press [Copy Output...]. 

 4. Press [Collated]. 

 5. Set the desired items. 

Banner Sheet 
Select whether to insert a banner sheet. The banner sheet 
will have the copy quantity and time printed on it. 

Collation Order 
Select whether to output copies in the order in which the 
documents were scanned (In Order), or to output from the 
last document that was scanned (Reverse Order). 

 6. Press [Close]. 

Set other features as necessary. 

 7. Enter the number of copies using the numeric keypad. 

 8. Load the first document. 

The scanning starts. 

 9. Load the next document. 

Repeat this step if you have more documents. 

 10. When all documents have been scanned, press [Last 
Original]. 



15

Potlačení pozadí 

Záložka obrazové kvality [Image Quality] > Potlačení pozadí 
[Background Suppression]
Dojde k potlačení barvy pozadí dokumentu při kopírování. 

Další funkce a vlastnosti pro nastavení při kopírování

Nastavení barevné denzity* 

Záložka obrazové kvality [Image Quality] > Nastavení barevné 
denzity [Adjust Color Density]
Nastavte barevnou denzitu barev pro a za účelem zvýraznění/
potlačení barvy. 

Posunutí obrazu

Záložka Nastavení layoutu [Layout Adjustment] > Posun 
obrazu[Image Shift]
Posune pozici obrazu tak, aby kopírované obrazy byly  
vytištěny: vlevo, vpravo, nahoře, dole, nebo na středu papíru. 

Smazání okrajů 

Záložka Nastavení layoutu [Layout Adjustment] > Smazání 
hran [Edge Erase]
Při kopírování dokumentů s okraji mohou být tyto okraje 
tištěny jako černý stín. Tato funkce může odstranit tyto stíny 
při kopírování dokumentů.

Vzorová kopie*

Záložka výstupního formátu [Output Format] > Vzorová kopie 
[Sample Copy]
Umožňuje tisk části dokumentu jako vzorek. 

Kopírování z paměti* 

Umožňuje tisk kopií posledního skenovaného dokumentu  
z paměti zařízení bez předchozího skenování.

*Volitelná paměť pro Color Board & Page pro IIT je požadována pro tyto funkce.

15 Copy

Other Copy Features 

* The optional Color Board & Page Memory for IIT is required. 

Background Suppression Adjust Color Density*

[Image Quality] tab > [Background Suppression]
Suppresses the background color of documents such as blue 
prints when copying. 

[Image Quality] tab > [Adjust Color Density]
Adjusts density level of a color in order to enhance or suppress 
the color.

Image Shift Edge Erase 

[Layout Adjustment] tab > [Image Shift]
Shifts the position of document images so that the images 
are copied on the left, right, top, bottom, or center of the 
paper. 

[Layout Adjustment] tab > [Edge Erase]
When you copy a document with borders, the edges of the 
document may be printed as black shadows. This setting can 
erase such shadows when copying. 

Sample Copy* Copy from Memory*

[Output Format] tab > [Sample Copy]
Allows you to copy a portion of a document as a sample. 

Makes additional copies of the last copied document without 
reloading. 
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 1.

 2.
 3.
 4.

Skenování

Následující příklady popisují základní funkce skenování do PC úložiště.

Krok 1   Vytvoření a sdílení složky 

Krok 2   Registrace bezpečné PC adresy 

Krok 3   Specifikace destinace úložiště

Krok 4   Skenování dokumentu

Pro využití této funkce je nutné nastavení sítě. (Konzultujte s administrátorem sítě.) 

Krok 1 Vytvoření a sdílení složky

Vytvořte sdílenou složku na vašem PC a nastavte parametry na její sdílení. Nastavte právo na možnost zápisu dat 
v této složce.

Nastavení sdílené složky

Kroky

Kdekoliv na vašem počítači vytvořte složku ke sdílení.

Tato složka bude používána k ukládání skenovaných dokumentů. Je doporučeno pojmenovat tuto 
složku stručně jako např. „scan001“, při použití jednobytových alfanumerických znaků.

Klikněte pravým tlačítkem myši na složku a vyberte Vlastnosti [Properties].

Klikněte na záložku Sdílení [Sharing].

Vyberte rozšířené vlastnosti sdílení [Advanced Sharing].

Poznámka

Poznámka

 Scan16

Scan

The following is an example of the basic Scan to PC procedure. 

Step 1 Creating a Shared Folder ........................................................................................................................................................ p. 16

Step 2 Registering a PC Save Address ............................................................................................................................................. p. 18

Step 3 Specifying the Save Destination PC................................................................................................................................... p. 20

Step 4 Starting the Scan Job............................................................................................................................................................... p. 21

Note To use the Scan to PC feature, you must first set up your network. (Consult your administrator.) 

Step 1 Creating a Shared Folder

Create a transfer destination folder on your computer and set it as a shared folder. Set write access to the shared 
folder.

Setting Up the Shared Folder 

Steps

 1. Anywhere on your computer, create a folder to be shared.

Note This folder will be used to store scanned data.
Giving this folder a short name such as "scan001", using single-byte alphanumeric characters, is 
recommended. 

 2. Right-click on the folder, and select [Properties].

 3. Click the [Sharing] tab. 

 4. Click [Advanced Sharing].
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 5.

1..

 6.

 7.

 8.
 9.
 10.

 11.

 1.
 2.

Vyberte sdílet tuto složku [Share this folder].

Ujistěte se, že název sdílené složky je shodný  
se jménem vytvořené složky.

Klikněte na Oprávnění [Permissions].

Nastavte odpovídající oprávnění na sdílení složky. 

Nastavte citlivě parametry sdílení v souladu  
s bezpečnostními pravidly ve vaší společnosti.

Klikněte OK 

Klikněte na záložku zabezpečení [Security].

Vyberte Editovat [Edit] nebo rozšířené možnosti [Advanced]  
a nastavte odpovídající oprávnění.

• Nastavte oprávnění s ohledem na bezpečnostní pravidla  
ve vaší společnosti.

Klikněte na Zavřít [Close].

Nastavení Windows Firewall

Kroky

Vyberte [Start] > Ovládací panely[Control Panel] > Systém a zabezpečení  
[System and Security] > [Windows Firewall].

Z menu vlevo vyberte Zapnout nebo  
vypnout bránu Windows Firewall.

2.

Poznámka

Poznámka

Poznámka

17 Scan

 5. Select the [Share this folder] check box.

Note Make sure that the folder name displayed in [Share Name] 
is the same as that of the folder you created in Step 1..

 6. Click [Permissions].

 7. Set the appropriate permissions. 

Note Set the permissions according to the security rules of your 
organization. 

 8. Click [OK]. 

 9. Click the [Security] tab. 

 10. Click [Edit] or [Advanced], and set the appropriate permissions. 

Note Set the permissions according to the security rules of your 
organization. 

 11. Click [Close].

Configuring Windows Firewall

Steps

 1. Select [Start] > [Control Panel] > [System and Security] > [Windows Firewall].

 2. From the menu on the left, click [Turn 
Windows Firewall on or off].

17 Scan

 5. Select the [Share this folder] check box.

Note Make sure that the folder name displayed in [Share Name] 
is the same as that of the folder you created in Step 1..

 6. Click [Permissions].

 7. Set the appropriate permissions. 

Note Set the permissions according to the security rules of your 
organization. 

 8. Click [OK]. 

 9. Click the [Security] tab. 

 10. Click [Edit] or [Advanced], and set the appropriate permissions. 

Note Set the permissions according to the security rules of your 
organization. 

 11. Click [Close].

Configuring Windows Firewall

Steps

 1. Select [Start] > [Control Panel] > [System and Security] > [Windows Firewall].

 2. From the menu on the left, click [Turn 
Windows Firewall on or off].
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 3.

 4.

 1.

 2.

Zaškrtněte „Vypnout bránu  
Windows Firewall (nedoporučuje se)“.

Potvrďte [OK].

Krok 2 Registrace zabezpečené PC adresy

Můžete uložit bezpečné PC adresy, které často používáte.  Lze zadat až 100 adres. Typ registrované adresy může mít 
server (SMB).

Kroky

V menu zařízení vyberte [Setup].

Vyberte položku [Server (PC Save Address)].

 Scan18

 3. Under [Home or work (private) network 
location settings], click [Turn off Windows 
Firewall (not recommended)].

 4. Click [OK]. 

Step 2 Registering a PC Save Address

You can register PC save addresses that you use often. The type of address that can be registered is server (SMB). 
You can register up to 100 addresses. 

Steps

 1. On the menu screen, press [Setup]. 

 2. Press [Server (PC Save Address)]. 

 Scan18

 3. Under [Home or work (private) network 
location settings], click [Turn off Windows 
Firewall (not recommended)].

 4. Click [OK]. 

Step 2 Registering a PC Save Address

You can register PC save addresses that you use often. The type of address that can be registered is server (SMB). 
You can register up to 100 addresses. 

Steps

 1. On the menu screen, press [Setup]. 

 2. Press [Server (PC Save Address)]. 
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 3.

 4.

Vyberte číslo serveru, který chcete registrovat.

Zmáčknete šipku nahoru pro zobrazení  
předchozího panelu a šipku dolů pro zobrazení  
dalšího panelu s čísly serverů.

Pokud chcete zobrazit specifické číslo serveru,  
zadejte jeho číslo a klikněte na [Go to].

Vyberte a nastavte požadované položky.

Název
Zadejte název serveru v max. délce  
36 jednobytových znaků. 

Název Serveru/IP adresa
Zadejte název serveru a IP adresu destinace.

Sdílený název
Zadejte sdílený název nastavený na složce SMB.

Uložit na
Zadejte adresář pro uložení dokumentů ve formátu UNC.

• Příklad: Pro uložení dokumentů v adresáři „bbb“ v adresáři „aaa“ při specifickém objemu „aaa“  
 vložte „aaa\bbb“.
 aaa\bbb

Uživatelské jméno
Pokud cílový adresář serveru vyžaduje vložit uživatelské jméno, vložte uživatelské jméno. 
• Pro aktivní adresář: 
 uživatelskéjméno@názevdomény (uživatelské jméno: až 32 znaků; název domény: až 64 znaků)
 Příklad: příklad\uživatel1 (příklad: názevdomeny; uživatel1: uživatelské jméno)
• Pro doménu ve Windows NT
 názevdomény\uživatelské jméno (název domény: až 64 znaků; uživatelské jméno: až 32 znaků)
 Příklad: příklad\uživatel1 (příklad: názevdomény; uživatel1: uživatelské jméno)
 • Pro pracovní skupiny
 lokální uživatel (až 32 znaků)
 Příklad: test - uživatel

Heslo
Pokud cílový server vyžaduje heslo, vložte heslo. Heslo může být v max. délce 32 znaků.

Číslo portu
Upřesněte číslo portu destinace v rozsahu 1 až 65535.
Pro zakázání této funkce zvolte [Default Port].

Při zvolení tlačítka procházet [Browse]
Je zobrazena hierarchie uložených názvů uložených destinací, serverů a složek. Projděte složky ke konkrétní  
destinaci pro uložení dokumentů. 

Poznámka
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 3. Select the server number that you want to register. 

Note Press [ ] to display the previous screen, and 
press [ ] to display the next screen.

If you want to display a specific server number 
at the top, enter that number in [Go to].

 4. Select and set the desired items.

Name
Enter the name of the address using up to 18 double-byte 
(36 single-byte) characters.

Server Name / IP Address
Enter the server name and IP address of the transfer 
destination.

Shared Name
Enter the shared name set to the SMB folder.

Save in
Enter the directory in which to save documents, in UNC 
format.

Example: To save documents in the directory "bbb" located in the directory "aaa" in the specified volume "aaa", 
enter "aaa\bbb".
aaa\bbb

User Name
If the transfer destination server requires you to enter a user name, set the user name.

For an active directory
user name@domain name (user name: up to 32 characters; domain name: up to 64 characters)
Input example:  user1@example.com (user1: user name; example.com: domain name)

For a Windows NT domain
domain name\user name (domain name: up to 64 characters; user name: up to 32 characters)
Input example: example\user1 (example: domain name; user1: user name)

For a work group
local user (up to 32 characters)
Input example: Test-User

Password
If the transfer destination server requires you to enter a password, set the password. 

The password can be up to 32 characters. 

Port Number
Specify the port number of the transfer destination within the range of 1 to 65,535. 

To disable this function, select [Default Port]. 

When the [Browse] button is selected
The hierarchical structure of the names of the save destination servers and folders is displayed. Trace through the 
hierarchy to specify the save destination.
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Important

 5.

 1.
 2.

 3.

Při zvolení tlačítka smazat vstup [Delete Entry].
Data ve vybraném adresáři mohou být smazána. Pro smazání uložených dat vyberte Smazat [Delete].

Smazaná nastavení již nelze obnovit.

Po vyplnění všech parametrů zmáčkněte Uložit [Save].

Krok 3 Specifikace uložené destinace v PC

Specifikace destinace pro uložení skenovaných dokumentů. 

Kroky

V menu na displeji vyberte Skenování do PC [Scan to PC].

Vyberte [Server Save Destination].

Vyberte přednastavené úložiště [Preset Server]. 

 Scan20

When the [Delete Entry] button is selected
The registered information of the selected address can be deleted. To delete the registered information, select 
[Delete].

Important Settings cannot be restored once they are deleted.

 5. After completing the settings, press [Save].

Step 3 Specifying the Save Destination PC

Specify the server on which to save scanned data. 

Steps

 1. On the menu screen, press [Scan to PC].

 2. Press [Server Save Destination].

 3. Press [Preset Server]. 
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 4.

 5.

 1.

Important

Note

 2.

Document guide

Vyberte serverové úložiště. 

Vybrána mohou být pouze  
registrovaná čísla.

Pro zobrazení předchozího panelu zmáčkněte  
šipku nahoru. Pro zobrazení následujícího  
panelu zmáčkněte šipku dolů.

Pokud chcete zobrazit specifické číslo serveru,  
zadejte jeho číslo a klikněte na [Go to].

Zmáčkněte uložit [Save].

Zařízení zkontroluje připojení  
na vybranou destinaci. 

V případě nenavázání spojení se na dotykovém displeji zobrazí chybová hláška.
Prosím potvrďte a zkontrolujte nastavení.

Krok 4 Skenování dokumentu

Vložte dokument a začněte skenovat.

Při táhnutí dokumentu nebo jeho postrkávání vpřed můžete způsobit poškození skenu. 

V případě skenování děrovaného dokumentu, vkládejte dokument tak, aby děrovaná část procházela skenerem 
jako poslední. V opačném případě může dojít k poškození dokumentu.  

Kroky

Zarovnejte originální dokument s vodičem do podavače skenovanou  
stranou dolů. Vkládejte dokument, dokud se proces nezastaví.

Je možné posunout vodič dokumentu vpravo  
pro zarovnání skenovaného dokumentu. 

Dokument je automaticky unášen a krátkodobě zastavován.
Následně zařízení začne automaticky skenovat dokument. 

Podržte dokument ve správné pozici do doby,  
než bude unášen. Pokud je dokument dlouhý  
je možné vypadnutí ze zařízení doporučuje  
se držet dokument v dané pozici. 
Pokud se objeví chybová zpráva na displeji,  
postupujte podle návodu na displeji. 

Odeberte dokumenty na výstupním podavači zařízení.

Poznámka

Poznámka

Poznámka

Poznámka

21 Scan

 4. Specify the save destination server. 

Note Only the numbers that are registered can be 
selected. 

Press [ ] to display the previous screen, and 
press [ ] to display the next screen.

If you want to display a specific save 
destination server at the top, enter that number 
in [Go to].

 5. Press [Save].

Note The machine checks the connection with the 
destination.

When the machine fails to establish a connection with the destination, an error message is displayed. In 
that case, press [Confirm], and verify the settings. 

Step 4 Starting the Scan Job

Load the document and start scanning. 

Important If you hold down or pull the document while it is being scanned, the document may get jammed.

When loading a hole-punched document, insert the edge with the holes last. If you insert the edge with the holes 
first, the document may get jammed. 

Steps

 1. Align the document against the document guide with the side 
to be scanned face down, and insert it all the way until it stops. 

Note You can shift the document guide to the right to shift 
the scanning position of the document. 

The document is automatically conveyed and stops 
momentarily. 
Then the machine automatically starts scanning the 
document. 

Important Do not release your hands from the document 
until it is conveyed. If the document is long, it 
might fall off the machine. 

Note When a problem occurs, an error message is 
displayed on the touch screen. Resolve the 
problem according to the message. 

 2. Remove the document that is output. 

Document guide
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Steps

 1.
 2.
 3.
 4.
 5.

Tisk

Tisk pomocí tiskového ovladače

Následující informace popisují tisk pomocí tiskového kontroléru.

Proces tisku je závislý na používané aplikaci. Více informací naleznete v dokumentaci pro danou aplikaci. 

Následující informace popisují příklad tisku z aplikace Windows WordPad

Ujistěte se, že máte nainstalovaný tiskový kontrolér na vašem počítači z dodaného DVD. 

Reference – Více informací o vlastnostech a možnostech tisku naleznete v nápovědě pro tiskový kontrolér na 
zařízení. Pro její zobrazení zmáčkněte Pomoc [Help].

Z menu soubor [File] vyberte tisk [Print].

Vyberte zařízení [FX DocuWide 3035] a v případě potřeby zvolte Vlastnosti [Preferences]. 

Vyberte položky podle potřeby.

Potvrďte [OK].

V dialogovém okně, klikněte na tisk [Print].

Reference

Kroky

Poznámka

 Print22

Print

Printing Using the Print Driver

The following describes how to print using the print driver.
The print procedure varies depending on the application being used. For details, refer to the documentation for your 
application. 
The following describes as an example how to print from Windows WordPad.

Note Make sure to have the print driver installed on your computer using the supplied Utilities DVD. 

Refer For information on the Print features, refer to the print driver help that is displayed when you click [Help] on the 
print driver screen. 

Steps

 1. From the [File] menu of your application, select [Print]. 

 2. Select [FX DocuWide 3035], and click [Preferences] as necessary. 

 3. Set each item as necessary. 

 4. Click [OK]. 

 5. On the [Print] dialog box, click [Print]. 
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 1.
 2.
 3.
 4.

 5.

 6.

 7.
 8.
 9.

Zabezpečený tisk

Zabezpečený tisk je funkce umožňující dočasné uchování dat k tisku (spojeno s ID uživatelem a nastaveným hes-
lem) a jejich následný tisk po zadání hesla z ovládacího panelu zařízení.
Jedná se o vhodnou funkci, umožňující nastavení ID uživatele a hesla pro vybraný dokument. Uživatel tak může 
bezpečně tisknout citlivé dokumenty bez obav, že je zhlédne jiný uživatel.

Krok 1 Zadání úlohy zabezpečeného tisku pomocí tiskového kontroléru ....................................................strana 23

Krok 2 Tisk úlohy zabezpečeného tisku z ovládacího panelu zařízení............................................................strana 24

Zadání úlohy zabezpečeného tisku pomocí tiskového kontroléru

Kroky 

Příklad: Zabezpečený tisk z aplikace Windows WordPad.

Z menu soubor [File] vyberte tisk [Print].

Vyberte zařízení [FX DocuWide 3035] a v případě potřeby zvolte Vlastnosti [Preferences]. 

Vyberte záložku Základní [Basic].

V položce typ úlohy [Job Type]  
vyberte zabezpečený tisk [Secure Print].

Vložte uživatelské ID [User ID] a heslo [Password].

Vložte uživatelské ID [User ID]  
v maximální délce 24 jednobytových alfa- 
numerických znaků a číselné heslo [Password]  
v rozsahu 4 až 12 jednobytových znaků. 

Z položky nahrazení jména dokumentu [Retrieve  
Document Name], vyberte [EnterDocument Name]  
nebo [Auto Retrieve].

Při výběru vložení jména dokumentu vyberte  
[EnterDocument Name], vložte název  
dokumentu v max. délce 24 jednobytových  
alfanumerických znaků

Potvrďte [OK].

Nastavte všechny položky podle potřeby a potvrďte [OK] v záložce Základní [Basic].

V dialogovém okně, klikněte na tisk [Print].

Poznámka

Poznámka

23 Print

Secure Print

Secure Print is a feature that allows you to temporarily store print data (to which a user ID and password is set) in the 
machine to print it only with the print command from the machine's control panel. 
Secure Print is a convenient functionality, that allows you to set a user ID and password to a document, and so you 
can print private and confidential documents without worrying about other people might seeing those documents.

Step 1 Submitting a Secure Print job using the print driver ................................................................................................... p. 23

Step 2 Printing the Secure Print Job on the Machine................................................................................................................ p. 24

Step 1 Submitting a Secure Print job using the print driver 

Steps

Example: When submitting a Secure Print job from Windows WordPad 

 1. From the [File] menu of your application, select [Print]. 

 2. Select [FX DocuWide 3035], and click [Preferences]. 

 3. Click the [Basic] tab. 

 4. From [Job Type], select [Secure Print]. 

 5. Enter [User ID] and [Password]. 

Note Enter [User ID] using up to 24 single-byte 
alphanumeric characters and [Password] 
using 4 to 12 single-byte numbers. 

 6. From [Retrieve Document Name], select [Enter 
Document Name] or [Auto Retrieve]. 

Note When [Enter Document Name] is selected, 
enter the document name in [File Name] 
using up to 24 single-byte (12 double-byte) 
characters. 

 7. Click [OK]. 

 8. Set each item as necessary, and click [OK] on the [Basic] tab. 

 9. On the [Print] dialog box, click [Print]. 
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 1.

 2.

 3.

 4.

Krok 2 Tisk úlohy zabezpečeného tisku z ovládacího panelu zařízení
Pro tisk zabezpečené úlohy použijte dotykový panel zařízení.

Kroky

Na hlavním panelu vyberte zabezpečený tisk [Secure Print].

Vyberte uživatelské ID spojené s dokumentem.

Zmáčkněte Obnovit [Refresh] pro zobrazení  
nejnovějších informací. 
Pomocí šipek se posunete v panelu vzhůru  
a níže na další panely. 

Vyberte seznam tiskových úloh [Job List].

Vložte heslo a potvrďte [Confirm].

Pokud není zvoleno heslo nebo jste  
u prostředí Administrátora, tak se tato  
obrazovka nezobrazí.

Poznámka

Poznámka

 Print24

Step 2 Printing the Secure Print Job on the Machine

Use the machine's control panel to print the Secure Print job stored in the machine.

Steps

 1. On the menu screen, press [Secure Print].  

 2. Select the user ID with which you submitted the Secure 
Print job. 

Note Press [Refresh] to display the latest information. 

Press [ ] to display the previous screen, and 
press [ ] to display the next screen. 

 3. Press [Job List]. 

 4. Enter the password, and press [Confirm]. 

Note If a password is not set, or if you are in the 
Admin mode, the [Password] screen does not 
appear. 
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 5.

 6.

 7.

Vyberte dokument k tisku. 

Zmáčkněte Obnovit [Refresh] pro zobrazení  
nejnovějších informací. 
Pomocí šipek se posunete v panelu vzhůru  
a níže na další panely.

Potvrďte tisk [Print].

Na potvrzovacím panelu vyberte z možností Tisknout  
a Smazat [Print and Delete] nebo Tisknout a Uložit [Print  
and Save].

Pro stornování tisku úlohy zmáčkněte  
storno [Cancel].

Tisknout a smazat
Po vytištění úlohy dojde ke smazání dat uživatele.

Tisknout a uložit
Po vytištění zůstanou data uložená na disku zařízení.

Poznámka

Poznámka

25 Print

 5. Select a file you want to print. 

Note Press [Refresh] to display the latest information. 

Press [ ] to display the previous screen, and 
press [ ] to display the next screen. 

 6. Press [Print]. 

 7. On the print confirmation screen, press [Print and Delete] 
or [Print and Save]. 

Note Press [Cancel] to cancel printing of the job. 

Print and Delete
Deletes the Secure Print job stored in the machine after 
printing. 

Print and Save
Does not delete the Secure Print job stored in the machine 
even after printing. 
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Steps

 1.
 2.

8..

 3.

Výměna/seříznutí papírové role

Zavedení papíru na roli číslo 1 a 2.

Jakmile je papír zaveden, odřízněte náběhovou hranu papíru.

POZOR

Role papíru je těžká. Při zvedání role papíru, držte roli vždy oběma rukama, pro bezpečnost Vašich zad pokrčte 
kolena.  
Shození či kymácení role může vést ke zranění. Vždy manipulujte s rolí s nejvyšší opatrností. 

Při manipulaci s rolí dejte pozor na přiskřípnutí prstů. 

Při odlepování pásky držící papír na konci role se ujistěte, že veškeré lepící materiály byly odebrány z papíru. 
Jakýkoliv zbytek lepidla může způsobit snížení tiskové kvality. 

Neotevírejte kryt na nože pro odřezávání papíru pro roli 1 a 2.

Při změně typu papíru, jeho formátu, plošné hmotnosti vždy změňte nastavení v knihovně médií.  
Více informací o změně nastavení v knihovně médií naleznete v uživatelském průvodci (User Guide).

Mějte před výměnou připravenou novou roli papíru a proveďte výměnu dle následujících instrukcí.

Otevřete čelní dveře.

Vytáhněte oběma rukama jednotku s rolí. 

Pokud chcete pouze oříznout  
náběhovou hranu, postupte k bodu 8.

Vyndejte násadu na roli papíru.

Kroky

Poznámka
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 4.

 5.

 6.

 7.

 8.

 9.
 10.

 11.

2 1

2

1

Poznámka

Poznámka

Při vytahování zmáčkněte páčku na konci násady (➀), vytáhněte 
násadu z  jádra role papíru (➁).

Uvolnění západky jejím zvednutím umožní vytáhnout  
násadu z jádra papírové role.

Při zvednutí západky na konci násady (➀) nasaďte novou roli 
papíru v souladu s velikostí papírové role podle měřítek  
na násadě (➁).

Při nasazování nové role dejte pozor, abyste nandávali  
roli na stabilní podlaze bez rizika podklouznutí,  
pádu nebo převrhnutí. 

Zkontrolujte směr odvinutí papíru z role a vraťte násadu s rolí  
zpět na místo. 

Otáčejte rolí, dokud se hrana papírové role nedotýká válce. 
Papír je automaticky navinut dle potřeb a následně zastaven  
v požadované pozici.

Pokud papír není navíjen pravidelně je možné,  
že je poškozena náběhová hrana papíru role.  
Odřízněte správně náběhovou hranu pomocí  
dedikovaného nástroje před vložením nebo pro  
opakované vložení papíru.  

Zmáčkněte tlačítko řezání <Cutter>.
Náběhová hrana je oříznuta.

Pokud zmáčknete tlačítko pouze jednou, dojde  
k odříznutí papíru o délce 210mm. Pokud tlačítko  
podržíte, bude papír navíjen do doby, než tlačítko  
pustíte a řez se provede v této  pozici.

Odeberte odříznutý papír.

 Lehce postrčte jednotku s rolí zpět do zařízení a čekejte dokud  
se nezastaví.

 Zavřete přední dveře.
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Steps

 1.

Výměna spotřebního materiálu

Doporučujeme následující spotřební materiál, který je vyráběn pro toto zařízení a splňuje tak vysoké  
nároky na kvalitu zařízení.

Typ kód produktu množství/krabice

Nádoba s tonerem CT200647 1 jednotka/krabice

Odpadní nádoba na toner CWAA0608 1 jednotka/krabice

Použití nedoporučeného spotřebního materiálu může vést ke snížení tiskové kvality, snížení výkonu a zkrácení 
životnosti zařízení či jeho dílů. Používejte pouze doporučený spotřební materiál společnosti Fuji Xerox. 

Při výměně nádoby s tonerem či odpadní nádoby na odpadní toner může dojít k vysypání toneru na zem. 
Doporučuje se položit papír na zem nebo jinou vrstvu pro ochránění podlahy.

Je doporučeno, abyste vždy měli tyto náhradní díly (materiál) k dispozici.  

Objednání odpadní nádoby na toner je závislé na typu smlouvy.

Doplnění toneru

Když dojde ke snížení množství toneru, zařízení zobrazí na dotykovém displeji následující zprávy.

Doplňte brzy toner

Zřízení může kopírovat přibližně dalších 500 stran od prvního zobrazení zprávy.

Doplňte toner
Doplňte toner. Zařízení nebude dlouho schopné tisknout či kopírovat, pokud dojde k zobrazení této zprávy. 

Pokud je nízká hladina toneru, může dojít k zastavení tisku či kopírování. Obnovení funkce bude až po 
jeho doplnění. 

Mějte připraveny náhradní nádoby s tonerem pro výměnu dle následujících pokynů.

Ujistěte se, že zařízení není v procesu tisku, skenování, kopírování.  
Otevřete zadní kryt.

Pokud je používáno řešení na zachytávání skenovaných  
dokumentů, je zapotřebí ho složit.

Kroky

Poznámka

Poznámka

Poznámka

Poznámka
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 2.

 3.

 4.
 5.

 6.
 7.

 8.

2

1

2

1

Poznámka

Poznámka

Zatřeste s novou náplní toneru. 

S nádobou zatřeste přibližně 20x. 

Připevněte nádobu s tonerem do uchycení pro naplnění toneru.

(1) Zarovnejte výstupek na patroně nádoby toneru do správné 
 pozice na místo uchycení (➀).

(2) Snižujte levou část náplně nádoby toneru a zatlačte jej do 
 pozice pro uchycení až do polohy, kdy zapadne na místo (➁).

Posuňte páčku vlevo a zarovnejte ji do pozice se symbolem .

Lehce klepněte na horní část nádoby toneru, dokud všechen  
toner není v zařízení.

Vraťte páčku do původní polohy  (➀).

Odeberte prázdnou nádobu na toner (➁). 

Spodní část použité nádoby na toner může nést malé  
množství toneru. Manipulujte s nádobou opatrně,  
aby nedošlo k přenosu toneru na vaše ruce či oblečení.

Prázdné nádoby na toner vraťte zpět společnosti  
Fuji Xerox.

Zavřete zadní kryt.

Výměna odpadní nádoby na toner

V okamžiku naplnění odpadní nádoby na toner se na dotykovém displeji zařízení objeví jedna z následujících zpráv. 
Postupujte dle pokynu na displeji. 

Vyměňte brzy odpadní nádobu na toner.

Zařízení může tisknout nebo kopírovat přibližně 2000 stran než bude zobrazena tato zpráva.

Vyměňte odpadní nádobu na toner.
Vyměňte odpadní nádobu na toner. Pokud se zobrazí tato zpráva, není možné tisknout ani kopírovat. 
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 2.

 3.

 4.
 5.

Při výměně mějte připravenou novou odpadní nádobu na toner. Nádobu vyměňte dle následujících pokynů.

Kroky

Ujistěte se, že zařízení nepracuje. Pro otevření horní jednotky  
zatáhněte za uvolňovací páčku. 

Opatrně odeberte odpadní nádobu na toner.

Uzavřete nádobu přiloženým uzávěrem.

Uložte odpadní nádobu do dodané tašky a vraťte jej  
společnosti Fuji Xerox nebo vašemu dealerovi. 

Připevněte prázdnou odpadní nádobu na toner.

Zavřete horní jednotku.

Dejte pozor na přiskřípnutí prstů.

Ujistěte se, že jste prázdnou nádobu na toner umístili  
správně. Pokud ne, zařízení samo rozpozná špatné  
umístění a po uzavření horní části zařízení zobrazí  
zprávu na displeji. Než bude provedena náprava,  
nebude zařízení provozuschopné.

Poznámka
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 1.
 2.

Odstranění zaseknutého papíru

Odstranění zaseknutého papíru 

V případě zaseknutí papíru dojde k zastavení zařízení a k zobrazení zprávy na dotykovém displeji. Postupujte dle 
pokynu na displeji.

VAROVÁNÍ

Nepokoušejte se odstranit papír zaseknutý uvnitř produktu, speciálně papír zaseknutý v oblasti fixační jed-
notky nebo nahřívacím válci. 
V opačném případě může dojít ke zranění či spálení. Vypněte zařízení a kontaktujte servis společnosti Fuji 
Xerox.

Vždy následujte bezpečnostní pokyny na zařízení nebo na dodaném spotřebním materiálu. 
Nedotýkejte se oblastí s označením „vysoká teplota“ nebo „vysoké napětí“ pro minimalizaci rizika popálení 
nebo elektrického šoku. 

Zaseknutí papíru v jednotce s rolí

Kroky

Otevřete čelní dveře.

Vytáhněte jednotku s rolí oběma rukama ven.

Papír je oříznut
Odstraňte zaseknutý papír.

Papír není oříznut
Otáčejte rolí papíru zpět. Poté znovu navinujte papír. 
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 1.
Reference

Papír je zaseknut na roli číslo 2, ale papír  
nelze nalézt na roli číslo 2.
Vytáhněte roli číslo 1 a odstraňte zaseknutý papír.

Opatrně zastrčte roli zpět do zařízení

Zavřete čelní dveře

Zaseknutý papír v horní jednotce

Kroky

Pro otevření horní jednotky zatáhněte vzhůru za uvlňovací páčku. 

Odstraňte zaseknutý papír ze zařízení.

Pokud po otevření není papír vidět, zmáčkněte  
zelenou záložku [A] a odstraňte papír  
z podávacího prostoru.

Vraťte zelenou záložku [A] do původní polohy.

Zavřete horní jednotku.

Provádějte opatrně z důvodů rizika přiskřípnutí prstů.

Zaseknutý papír ve fixační jednotce

Kroky

Otevřete horní jednotku a odstraňte zaseknutý papír ze zařízení.

Návod naleznete v krocích 1 a 2 pro “Zaseknutý papír v horní jednotce“ (strana 32).

Uvolňovací páčka  
pro otevření horní  
jednotky.
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2

1

2

1

Pokud zaseknutý papír není vidět po otevření zařízení, sklopte  
směrem k sobě manuální nakládací stůl (➀) 
a kryt fixační jednotky (2). 

Vytáhněte zelenou páčku (➀) a odstraňte papír 
z vykládacího podavače (➁).

Vraťte zelenou páčku do původní pozice.

Zavřete kryt fixační jednotky a odklopte manuální podávací stůl.

Zavřete horní jednotku.

Provádějte opatrně z důvodů rizika přiskřípnutí prstů.

Odstranění zaseknutých dokumentů

Pokud dojde k zaseknutí dokumentu ve skenovací jednotce, zařízení zastaví činnost a zobrazí odpovídající zprávu na 
dotykovém panelu. Odeberte zaseknutý dokument dle pokynů na displeji a znovu vložte dokument pro skenování. 

Kroky

Vytáhněte kryt skeneru k sobě a poté ho zvedněte. 

Odeberte zaseknutý dokument.

Vraťte kryt skeneru do původní pozice.



34

　　

1 2 3

4 5 6

7 8 9

0 ＃

C

Services Home Copy (Not In Use) Review

Job Status

Machine Status

Dial Pause Speed Dial

ABC DEF

GHI JKL MNO

PQRS TUV WXYZ Interrupt

Start

Stop

Clear All

Log In / Out

Energy Saver

Řešení problémů

Obecné 

Otázka 1: Zařízení je zapnuté, ale dotykový displej nenaběhl.

Odpověď:  Zkontrolujte, zda není zařízení v energeticky  
 úsporném módu. Pro opuštění tohoto režimu  
 zmáčkněte tlačítko <Energy Saver> na panelu  
 zařízení. 

Otázka 2:  Kde zkontroluji informace o vyúčtování?

Odpověď:  Toto je možné zkontrolovat na dotykové obrazovce  
 v panelu [Billing Information]. Zmáčkněte tlačítko  
 <Machine Status> a poté v záložce [Billing Information]. 

Měření 1 
Zobrazí celkovou potištěnou plochu  
zařízením. (Jednotka m2)

Měření 2
Zobrazí celkovou délku potištěného média.  
(Jednotka m nebo 0,1m)

Otázka 3:  Čáry nejsou při tisku či kopírování zarovnány. 

Odpověď:  Zkontrolujte, zda nenajdete mezery ve spojení skenovacích senzorů. Následně proveďte skenování  
 kalibrace [Scan Sensor Gap Calibration] > [Auto Adjust] v menu displeje v tomto pořadí. Pak můžete  
 automaticky kalibrovat mezery pomocí použití kalibračního archu, který je součástí zařízení. 

Problémy se skenováním

Otázka 4: Jak velký objem dat skenovaných dokumentů lze uložit ve složce zařízení?

Odpověď:  Lze uložit okolo 12 GB.  
 Pravidelně data ukládejte na počítač nebo mažte nepotřebná data.  

Otázka 5:  Mohou být smazána data ve složce skenování?

Odpověď:  Lze nastavit mazání souborů po jejich kopírování do PC. Případně lze data mazat manuálně. Použijte  
 CentreWare Internet Services pro následující výběr v tomto pořadí [Scan] > [Mailbox List] > [Open  
 Mailbox] > [Delete] 
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Troubleshooting

Common Items

Q1 The power is on, but the screen is blank.
A Is the printer in the Energy Saver mode? 

Press the <Energy Saver> button on the control panel to 
exit the Energy Saver mode. 

Q2 Where can I check the billing information?
A You can check it on the [Billing Information] screen.

Press the <Machine Status> button on the control panel, and 
press the [Billing Information] tab.

 Meter 1
Displays the sum total of the surface area printed by the 
machine so far. (Unit: m2)

 Meter 2
Displays the sum total of the length printed by the machine 
so far. (Unit: m or 0.1 m)

Q3 The lines on copies or prints are misaligned. 
A Check whether you find the gaps at joints between the scanning sensors.

If this applies, select [Scan Sensor Gap Calibration] > [Auto Adjust] in this order on the menu screen. Then you 
can automatically calibrate the gaps by using the calibration chart that came with the machine.

Scanning Problems

Q4 How much scanned data of documents can the machine's Folder hold?
A Approximately 12 GB.

Periodically move the data to other computers, or delete unnecessary data.

Q5 Can the scanned data in the Folder be deleted?
A You can set the machine to delete the data when it is imported to a computer. 

You can also delete it manually. Use CentreWare Internet Services to select [Scan] > [Mailbox List] > [Open 
Mailbox] > [Delete] in this order.
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